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PowerTeacher Pro 

PowerTeacher Pro is the new web-based gradebook solution for PowerSchool.  It can be run on any 

device on which you can launch a web browser, including computers, laptops, Chromebooks, tablet 

devices (such as iPads, Windows Surface tablets), or even Smart Phones. 

 

Launching PowerTeacher Pro 

PowerTeacher Pro is launched from the PowerTeacher Portal. 

 

To launch PowerTeacher Pro 

1. Log into the PowerTeacher Portal 

2. Click on the link for PowerTeacher Pro from either: 

a. Left Navigation Menu, or 

b. Under the Current Classes 

3. PowerTeacher Pro will open and defaults to the Assignments page 

 

The initial “Getting Started” screen can help to identify where you can perform various functions: 

 

 
 

Basic Navigation and Setup 

In the Top Navigation Bar, there are 3 helpful links: 

1. PowerSchool logo – Takes you back to the PowerTeacher Portal 

2. HELP – Content-Specific Help or review the Getting Started screen 

3. Sign Out – Click on your name to sign out of PowerTeacher 

 

The Left Navigation Bar has content-specific icons: 

1. Grading (Assignments and Grades) 

2. Students (Individual Student information pertaining to Assignments, Standards Progress, 

Comments, Demographic information and the Quick Lookup screen) 

3. Progress (Standards and Traditional) 

4. Reports (Individual Student Grade Report, Multi-Function Assignment Report, and Student 

Roster Report – More to come!) 

5. Settings (Gradebook Display Settings) 

6. Apps (PowerTeacher Pro and where you will can links to third party apps that are integrated 

with PowerSchool/PowerTeacher) 
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Viewing and Adding Class Descriptions 

Add more details about the class, such as a description or the syllabus, which will be visible in the 

PowerSchool Student and Parent Portals, and in PowerSchool Mobile. 

 

To add a class description: 

1. Click Settings from the left navigation menu 

2. Select Descriptions 

3. The details pane for the selected class opens. 

4. Enter the class description, syllabus, or other details in the Description field 

5. Click the arrow to the left of another class name to open the details pane and add a description 

6. Click Save 

 

Setting Up Display Preferences 

Customize the display settings to control how class names appear in your gradebook—by period and 

day, by section number, or alphabetically. Additionally, define whether or not to show standards and 

traditional grades. 

 

To set up display preferences: 

1. Click Settings 

2. Select Display 

3. Open the "Display and Sorting" menu and select an option, such as Section Number (sort by 

Course Name), to change the way class names appear 

4. Check Show Standards Pages and Links to use the standards grading features in the gradebook 

5. Check Show Standards on Assignments to show standards aligned to assignments in the 

gradebook 

6. To change the sort order of the Traditional and Standards navigation links in the Grading menu 

and Quick Menu, open the Navigation Links Sort Order menu and choose Standards, Traditional 

(The default setting is Traditional, Standards.) 

7. Check Show Traditional Grade on Pages to display traditional grades in the gradebook (In the 

Preview Release, Traditional Grades always appear). 

8. Under Student Names, use the Display menu to define how students’ names will appear in the 

gradebook, such as by first, then last name 

9. Use the “Sort Students by” menu to choose how to sort the lists of students, such as by first 

name 

10. To view new students’ names at the bottom of class lists, check Add newly enrolled students to 

the bottom 

11. To conceal the names of pre-registered students from class lists, check Hide pre-registered 

students 

12. Click Save 
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Creating Categories 

Categories are broad classifications in which you group similar types of assignments. Examples of 

categories are homework, tests, and quizzes. Set up your own categories, or use district-created 

categories. District-created categories are identified by an icon that looks like a school house next to the 

category name. 

 

 
 

To view Categories: 

1. Click on the Grading icon from the Left Navigation Menu 

2. Select Categories 

 

To create Categories: 

1. Click on the Create button from the Top Navigation Menu 

2. Select Category 

3. From the Select Classes dropdown, choose the classes for which the new category applies 

4. Type in a New Category Name 

5. Choose the color with which assignments of this category will be displayed in the gradebook 

6. Set the Status to Active for categories that you wish to use (Categories can be set to Inactive if 

no longer used.) 

7. Enter a description, if desired 

8. On the Assignment Defaults tab, set up how assignments of this category will be initially 

configured: 

a. Score Type 

b. Points 

c. Whether or not to Publish Scores Immediately 

d. Whether or not to count the assignment in the Final Grade 

i. For classes using traditional grading, it would be helpful to set this as the default 

for most categories 

ii. For classes using only standards-based grading, this should be unchecked for all 

categories 

9. Click Save to create the new category 
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Setting up Grading Preferences 

Administrators may choose to set up the grading preferences, such as weights and to allow low score 

drops, at the district or school level for all teachers. However, if teachers are permitted to do so by their 

district and school leaders, teachers may define some of the grading preferences for the classes they 

teach. 

 

At this time, weighting is available for Traditional Final Grades.  They are not available for Standards-

based grading at the time of this document. 

 

To Set up Grading Preferences 

1. Click on the Class icon from the left navigation menu 

2. Choose Grade Calculations 

3. The available Reporting Terms for the selected class will be displayed.  If any Grading 

Preferences are allowed to be set by the teacher, the Edit Weights and/or Edit Drops columns 

will have a green checkmark.  If the School or District has set these, they may be locked and not 

editable. 

4. Click on the Pencil button in the actions column next to the desired term 

5. To change the weighting 

a. Click on the Formula tab 

b. Select the Type (Total Points or Category Weighting) from the dropdown 

i. Total Points will default to 100% 

ii. Category Weighting will then make the Attribute of the Category available 

iii. Select the Category and the desired weight 

iv. To add additional items, click on the Plus button. 

v. To remove items, click on the Minus button to the right of that item. 

c. While it is not recommended, you may mix Category Weights and Total Points 

d. Click the Save button and the Formula Type will appear next to the configured Reporting 

Term.  If a Reporting Term has not yet been configured, a message will appear that “A 

grade calculation formula has not been configured for this reporting term.  Defaulting to 

Total Points.” 

e. Click on the right-facing arrow next to the next class to continue to configure the 

Weighting for the class. 
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Working with Assignments 

 

Creating and Viewing Assignments 

View assignments on both the Assignments and Scoresheet pages.  Set up assignments at the beginning 

of a school term or at any time during the term. To save time, copy existing assignments or create 

duplicates while creating a new assignment. 

 

To create an assignment: 

1. Click Create 

2. Select Assignment 

3. Open the Select Classes menu and select a class or multiple classes. Click outside the Select 

Classes menu to close it. 

4. Enter the name of the assignment, such as Unit 1 Test 

5. Select the appropriate category 

6. Select a score type (Points, Percent, Letter Grade or Collected Only) 

7. Enter the number of score entry points, such as 80 

8. To include the assignment in students’ final grades, verify that Count in Final Grade is selected 

a. For classes using traditional grading, this is typically checked. 

b. For classes using only standards-based grading, this should be unchecked 

9. Enter the assignment due date.  The default due date is today’s date. 

10. Enter a description, such as This test covers all of the topics in Unit 1 

11. Click the Students tab 

12. Verify that the assignment applies to all students.  To apply the assignment to a selection of 

students, click Add/Remove Students. Then clear the check box next to the Filter area and check 

the boxes next to the selected students’ names. 

13. If aligning Standard(s) to this assignment, click the Standards tab 

14. Select the standard(s) that are aligned to the assignment 

15. To use the assignment score to calculate the Standards Scores, 

a. Select the standard(s) that are aligned to the assignment 

b. Click the “Show Selected Standards” tab 

c. Check the “Auto-Calculate Assignment Standards Scores” box 

16. Click the Publish tab 

17. Open the Publish Assignment menu and choose when to publish the assignment for students 

and parents 

18. To publish students’ scores once you’ve scored the assignment, check Publish Scores 

19. Click Save at the bottom of the Create window 

 

If you originally set up an assignment for a single class and wanted to use it for another section, you can 

duplicate the assignment for use in another class. 
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To duplicate an assignment for use in another class: 

1. Click Grading 

2. Select Assignment List 

3. In the list of assignments, locate an assignment that you’ve already created and click the Edit 

icon 

4. Click Duplicate at the bottom of the Edit window 

5. Open the Select Classes menu, clear the check box next to the currently selected class, and 

choose a different class.  Click outside the Select Classes menu to close it. 

6. Enter the assignment name, such as Unit 1 Test 

7. Use the same category, score type, score entry points, due date, description, and publication 

settings as the original assignment, or modify the values as needed 

8. Click the Standards tab 

9. Click Add/Edit Standards and, if needed, select a new set of standards that are aligned to this 

assignment 

10. Click Save and close the Edit window 

11. To verify that you copied the assignment to a different class, click the name of the currently 

selected class in the navigation bar at the top of the page and select the class that you copied 

the assignment to 

12. Locate the duplicated assignment in the list of assignments 

 

Working with Grades 

 

Entering Scores 

When entering scores, make sure to use the type of score that you set up when you created the 

assignment.  For example, use numbers for points and percentages or letters for letter grades. 

 

To enter scores: 

1. Click Grading 

2. Click Assignment List or Scoresheet 

3. From the Assignments or Scoresheet pages, enter a student’s assignment score by clicking in the 

cell where the student’s name intersects with the assignment name and type in the score 

 

NOTE:  If Standards are aligned to the assignment and when creating the assignment the “Auto-

Calculate Assignment Standards Scores” box is checked, the Standards score will automatically 

populate.  If this box is not checked or if the assignment is not graded on points, then you may 

enter the standards score by entering it directly into the Standards column when selecting the 

assignment from the Assignment List or the link to the assignment from the Scoresheet. 

 

View the assignment summary above the list of assignments to see its score type, as well as the 

student’s existing score details (if the assignment was previously scored), and the due date by clicking on 

a score cell. 
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By clicking the “Show More” link on the Scoresheet, you can view the Grade Scale. 

 

Using the Score Inspector and Score Indicators 

While you can enter scores manually, use the Score Inspector to provide more details about the 

student’s performance, such as when a student has a missing or late assignment. Also use the Score 

Inspector to enter a comment about a student’s score. 

 

To open the Score Inspector, click in a score cell on the Assignments or Scoresheet pages. 

 

Below is a list of Indicators available in the gradebook: 

 

Indicator Description 

 

Indicates that an assignment is missing 

 

Indicates that an assignment was collected 

 

Indicates that an assignment is late 

 

Indicates that an assignment is incomplete 

 

Marks that an assignment is exempt, Scores will appear 

as purple, italicized font 

 

Indicates that an assignment wasn’t completed due to 

the student being absent 

 

Indicates that a comment was added 
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Filling Scores 

Use the Fill Scores functions to either fill scores for one assignment for all of the students in a class, or to 

fill all assignment scores for one student. Scores will be filled in cells that do not already have scores.  

Additionally, use the fill scores functions to fill comments. 

 

To fill students’ scores for one assignment: 

1. For the selected assignment, click in a score cell on the Assignments or Scoresheet pages 

2. Enter the score or select the score indicator in the Score Inspector 

3. Click the Fill icon with the vertical arrows 

4. Click Save 

 

To fill multiple assignment scores for one student: 

1. For the selected student, click in a score cell on the Assignments or Scoresheet pages 

2. Enter the score or select the score indicator in the Score Inspector 

3. Click the Fill icon with the horizontal arrows 

4. Click Save 

 

To clear scores with the Fill Scores option: 

1. Click on the top cell of the scores to be cleared 

2. Clear the value from the score box on the score inspector 

3. Click the Fill icon with the vertical arrows 

4. Click Save 

 

Adding Comments 

As you enter scores or indicators for assignments, use comments to record specific details about student 

performance. Add comments manually or choose comments from the comment bank. 

 

Click the star next to a comment in the bank to set it as one of your favorite comments. Include smart 

text, such as <first name> or <he/she>, to personalize comments. 

 

To add a comment: 

1. Click the Comment icon in the Score Inspector 

2. Either enter a comment in the text box, or click Comment Bank and select a comment 

3. A blue Comment icon appears in the student’s score cell. 

4. Click Save 

5. Click the icon to read the comment 

 

Marking Assignments 

Use one of two methods to score an assignment—score a single assignment from the Assignments page, 

or score multiple assignments on the Scoresheet. 
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When on the Assignments List screen, for each assignment, you can easily see 

• The Category of the assignment 

• The number of student scores that were entered (if all were entered, a checkmark will appear) 

• The Due Date of the assignment 

• The Score Type and Total Points Possible 

 

To enter scores, score indicators, or comments for a single assignment: 

1. Click Grading 

2. Select Assignment List 

3. Click the name of an assignment 

4. View the assignment summary above the list of students to see which score type to use. 

5. Click in a student’s score cell and type a score, such as 72 

6. Click the Comment icon in the Score Inspector 

7. Enter a comment, such as “Needs to turn work in on time” 

8. Click the right-facing Score arrow in the Score Inspector to move to a standards score cell (if 

standards are aligned to the assignment and need to be entered if not calculated) 

9. View the assignment summary above the list of students to see which grade scale type to use. 

10. Enter a standards score for the student 

11. Click Save 

 

To enter scores, score indicators or comments for one or more assignments on the Scoresheet: 

1. Click Grading 

2. Select Scoresheet 

3. Click in a student’s blank score cell for the selected assignment and enter a score in the Score 

Inspector 

4. Click the vertical Fill icon to fill all of the blank score cells with the score you entered in the Score 

Inspector 

5. In the alert window that lists the number of scores that were filled, click Ok 

6. Click in a different student’s score cell for a different assignment and click the Exempt score 

indicator 

7. Click Save 

 

For classes using Traditional Grading, when you delete or edit a score, the values in the student’s 

Course Grade column are grayed out because they are being edited. Once you click Save, the 

student’s grades will be recalculated using the new score. 

 

Working with Final Grades 

Final grades are updated automatically throughout the term as you enter assignment scores in the 

gradebook. When the term comes to a close, however, you may have additional tasks to perform before 

submitting grades for report cards to make sure that your final grades are accurate. For example, you 
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may have to enter standards grades and modify individual scores. Occasionally, you may also need to 

modify a student’s final grade in a course based on effort, participation, or other performance factors. 

 

To modify a Traditional final grade: 

1. Click Grading 

2. Select Traditional 

3. Click a student’s final grade 

4. In the Score Inspector, edit the student’s grade 

For example, change a letter grade of A- to A, and a percentage of 91 to 94. 

5. Click Save (The upper-left corner of the student’s final grade cell will have a small triangle 

indicating a manually overridden grade. 

 

To modify a Standards final grade: 

1. Click Grading 

2. Select Standards 

3. Click a student’s final grade 

4. In the Score Inspector, edit the student’s grade 

5. For example, change a letter grade of a D to an S. 

6. Click Save (The upper-left corner of the student’s standards final grade cell will have a small 

triangle indicating a manually overridden grade. 

 

To revert to a calculated grade, click in the score cell and click the Revert/Undo button in the Score 

Inspector. 

 

 

Analyzing Student Performance 

Use the gradebook to analyze student performance at any time during the school year. Analyze 

performance throughout the term to ensure that students are mastering the skills and standards that 

you are teaching. Review students’ performance as you prepare to complete final grades for report 

cards, and then use the gradebook to prepare for and conduct parent-teacher conferences. 

 

Review how students in an entire class are performing using the Class Progress pages. The individual 

student pages provide helpful information during parent-teacher conferences to explain why a student 

earned a particular grade. 

 

Viewing Individual Student Progress 

 

To review an individual student’s performance: 

1. At the top of the gradebook window, select a class 

2. Click Students 

3. To view the first student’s performance, click Assignments 
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4. Review the student’s course grades and individual assignment scores, then open the Quick 

Menu and select Standards Progress 

5. Review the student’s standards scores for each reporting term, then click the Assignments icon 

for one of the standards 

6. Review the graph of standards scores, then click Show Metrics to review the student’s other 

standards statistics 

7. Click Students and select a different student to view his or her Standards Progress page 

 

Show Metrics Definitions 

 Most Recent – The average of the most recent score(s) 

 Mean – The mathematical average of the scores 

 Median – The middle of the scores (half of the scores are above this number and half are 

below) 

 Mode – The most common score achieved 

 Weighted Mean – The average of the scores based on the average of total weighted points 

 Highest – The highest score 

 

These statistical values are indicators of how well the student did on a specific standard. If any of the 

values are low, it may mean that the student needs additional practice on the skill or concept that 

you’re assessing, or you may need to revise the assignment. 

 

To view the student’s performance on additional standards, open the Quick Menu and select a standard. 

 

Professional Judgment Indicator 

The Professional Judgment Indicator appears when evidence exists for mastery that may differ from the 

student’s calculated standard score. 

 
 

When viewing the student’s progress on the individual standard, you may find that there are outliers 

which could be skewing the calculation.  You can use your professional judgment to evaluate the 

student’s level of mastery. 

 

 

 

Analyzing Class Progress 

To analyze the performance of an entire class, begin by selecting the class at the top of the gradebook 

window. Then, click Class. Depending on how the gradebook is set up, you can view class progress on 

traditional grades and standards grades. 
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To view traditional grades progress: 

1. From the Class menu, select Traditional 

The graph on the Traditional Grades Progress page shows the distribution of grades for the class 

for the selected reporting term. 

To the right of the graph, view a summary of the total number of students who have missing, 

late, or incomplete assignments. 

2. Click the graph to open the Traditional Grades Distribution Window 

3. On the left side of the Traditional Grades Distribution window, view the score distribution for 

each reporting term in the school year 

4. On the right, view the grade trends of the students in the class for the selected term, compared 

to the previous term 

 

A red arrow in the Grade column indicates that the student’s grade is trending down between 

the selected terms.  A green arrow indicates an upward trend.  No arrow indicates there has 

been no change. You can see which students are performing better or worse between terms. 

 

5. To compare trends between a different selection of subsequent terms, click a term in the Score 

Distribution column 

6. To close the window, click X in the upper-right corner 

 

To view standards grades progress: 

1. From the Class menu, select Standards 

The graph on the Standards Progress page shows the distribution of grades for each standard 

aligned to the course, for the selected class and reporting term. 

2. Click the graph to open the Standard Grades Distribution window 

3. On the left side of the Standard Grades Distribution window, view the score distribution for the 

selected standard for each reporting term in the school year 

4. On the right, view the grade trends of the students in the class for the selected term, compared 

to the previous term 

A red arrow in the Grade column indicates that the student’s level of mastery is trending down 

between the selected terms. A green arrow indicates an upward trend.  No arrow indicates 

there has been no change. 

5. To compare trends between a different selection of subsequent terms, click a term in the Score 

Distribution column 

6. To close the window, click X in the upper-right corner 

 

On the right side of the Standards Progress page, the number in the Assignments column indicates the 

number of assignments that you’ve used to give students opportunities to practice the standard or to 

assess their levels of mastery. 
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These statistical values are indicators of how well the group of student did on a specific standard. If any 

of the values are low, it may mean that there were not enough scores to adequately assess a standard 

or that the assignment did not properly assess the skill or concept that was introduced.  It could also 

mean that the instructional approach used to present the skill or concept may need to be adjusted (at 

an individual teacher level) or the curriculum itself is not effectively reinforcing the skill or concept 

(when comparing scores on standards between several classrooms). 

 

To view the assignments aligned to a standard: 

1. Click the Assignments icon next to a standard 

2. On the Standards Assignment Trend window, click the name of an assignment 

3. If needed, edit students’ scores in the column for the selected standard and click Save. 

 

 

PowerTeacher Pro Reports 

 

Individual Student Report 

This report is used to: 

• View or print a summary of the class activity per student, 

• Present a summary of student work to parents at conferences or to a principal during a review, 

or use the report as a midterm update for students and parents, 

 

You can choose to include course grades and attendance, assignments, category totals and comments.  

You can run the report for one or more students in your class rosters. 

 

To run the Individual Student Report: 

1. Click Reports 

2. Select Individual Student Report 

3. Enter a report title, such as Progress Report 

4. Open the Select Classes menu and choose the classes to include on the report 

5. To run the report for a selection of students rather than for all of the students in the classes, 

click Add/Remove Students 

6. All of the students are selected by default, so clear the check box to the right of the Filter area, 

then in the list of students, check the boxes next to individual student’s names 

7. In the Sort Options section, open the Layout menu and choose By Section, By Student 

8. To sort the report by students’ last names, open the Students menu and choose Last Name 

9. Verify that Show Percentages is selected to include students’ grade percentages in the report 

10. Open the Data To Include menu and check Course Grade Comments and Assignment Comments 

to include any comments that you’ve entered about the students in the report "Course Grades 

and Attendance," Assignments, and Category Totals are checked by default. 

11. Click the Data To Include menu again to close it 

12. To include students’ grades from the current term, use the default settings under Date Range 
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13. Scroll to the top of the page and click the Format tab 

14. Since you are including all of the available data in the report, leave the page orientation set to 

landscape to make the text easier to read 

15. Use the default option PDF for the report output 

16. To create a page break between students, check Page Break 

17. Choose to exclude row shading to save ink during printing 

18. Leave the “Include” check box clear for the Top Note option, since you don’t plan to include a 

note at the top of the report 

19. Leave the “Include” check box clear for the Bottom Note option, since you don’t plan to include 

a note at the bottom of the report 

20. To generate the report, click Run Report 

 

 

Dropped Students 

The only way to review a dropped student’s final grades is to use the Students link on the left and select 

the “Show dropped” link.  You can modify the final grade; however, you will not be able to see the 

student in your Scoresheet view. 

 

When running the report, check the “Include Dropped Students” checkbox, select the “Add/Remove 

Students” tab, check the box to clear all students, and check the box to the right of the dropped student. 

 

Class Roster Report 

This report is used to: 

• View or Print demographic information by class 

• To keep track of money collected for class field trips or as an emergency contact list 

 

You can choose to add blank columns and use the Order Arrows to arrange the columns for the desired 

layout. 

 

To run the Student Roster Report: 

1. Open the menu at the top of the gradebook window and select a class 

2. Click Reports 

3. Select Student Roster 

4. Enter a report title, such as Field Trip Roster 

5. Since you selected a class before you navigated to the Reports menu, it is already selected for 

the Classes option 

6. Verify that the report applies to all of the students in the selected class 

7. To sort the roster of students by last name, open the Students menu and choose Last Name 

8. Add columns of student information by opening the Add Columns menu and clicking Add next to 

Gender and Grade Level 
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9. Click Add next to Blank twice to include a column for taking attendance and one for tracking 

participation (A column titled “Name” is included by default to list the students’ names.) 

10. Click the Add Columns menu again to close it 

11. Enter Attendance as the title of the first blank column 

12. Enter Participation as the title of the second blank column 

13. Scroll to the top of the page and click the Format tab 

14. Open the Orientation menu and choose Portrait 

15. Use the default settings for the rest of the format options 

16. To generate the report, click Run Report 


